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AMIRIX Systems Inc. 
Warranty and Disclaimer 

WARRANTY 
AMIRIX Systems Inc., doing business under its trade name VEMCO, provides a one (1) year warranty period for the Product from date of shipment.  

VEMCO warrants that on the date of shipment all Products manufactured by VEMCO are free from defects in material and workmanship under normal use and service. This warranty 
applies to the components necessary for equipment upgrades, i.e. the VR1/VR2 to VR2W upgrade. With respect to transmitter products, while VEMCO is able to predict battery life with 

 

some certainty, VEMCO cannot guarantee that these Products will remain functional while submerged for extended periods of time. This warranty does not apply to any equipment, 
materials or design supplied by Buyer or a third party; re-battery services provided by VEMCO; Products for which VEMCO has not received payment; problems that results from: external 
causes such as accident, abuse, misuse; servicing not authorized by VEMCO; usage not in accordance with Product instructions; failure to follow the Product instructions or failure to 
perform preventative maintenance; usage of accessories, parts or components not supplied by VEMCO. 
 
This warranty shall survive delivery only on the conditions and subject to the limitations set forth below. 
 
NOTICE PERIODS 
To receive a warranty remedy for a Product, Buyer must contact VEMCO’s Customer Support Department during the warranty period to receive the Return Material Authorization (“RMA”) 
instructions. Each defective Product returned for warranty remedy must be shipped at the Buyer’s expense according to the RMA instructions and must include reasonable proof that the 
claimed defect is due to a matter embraced within the warranty set forth above and that such defect did not result from any act or omission of Buyer, including but not limited to any failure 
to operate and maintain the Product in accordance with VEMCO’s applicable written instructions. 
 
REMEDY 
VEMCO’s liability, and the Buyer’s exclusive remedy under this warranty, as to a defect in material or workmanship, is limited to the repair of such defect in the accessory, equipment or 
part in which the defect appears or, at VEMCO’s option, to the replacement of such accessory, equipment or part with a similar item free from defect. As to any item repaired by VEMCO 
or furnished as a replacement by VEMCO, VEMCO’s liability and the Buyer’s exclusive remedy to the repair or replacement of such item for any further defect in material or workmanship, 
provided VEMCO receives written notice at Halifax, Nova Scotia, of such further defect from BUYER within ninety (90) days after the repaired or replaced item is shipped to BUYER and 
provided that BUYER returns same to VEMCO as provided under “Notice Periods”. 
 
RETURNED ITEMS 
All repairs, replacements and corrections described above shall be performed by VEMCO at its plant at Halifax, Nova Scotia, or at such other place as may be mutually agreeable, and 
with reasonable care and dispatch in order that the Product, accessory, equipment or part will not be kept out of service longer than necessary. Return to BUYER of a repaired, 
replacement, or corrected accessory, equipment, part or Product shall be at VEMCO’s expense. Title to and risk of loss of the Product, accessory, equipment, or part returned to VEMCO 
pursuant hereto shall at all times remain with the BUYER, except that title to a returned accessory, equipment, part, or Product shall pass to VEMCO concurrently with shipment to 
BUYER of any item furnished by VEMCO to BUYER as a replacement therefore. VEMCO shall have only such responsibility for any Product, accessory, equipment, or part owned by the 
BUYER and in the possession of VEMCO as is chargeable by law to a bailee for hire, but shall not be chargeable for loss of use thereof. 
 
WEAR AND TEAR 
Normal wear and tear and the need for regular maintenance shall not constitute a defect under this warranty. 
 
DISCLAIMER AND RELEASE 
THE WARRANTIES, OBLIGATIONS AND LIABILITIES OF VEMCO AND THE REMEDIES OF BUYER SET FORTH HEREIN ARE EXCLUSIVE AND IN SUBSTITUTION FOR, AND 
BUYER HEREBY WAIVES AND RENOUNCES, ALL OTHER WARRANTIES AND OBLIGATIONS OF VEMCO AND ANY ASSIGNEE OF VEMCO AND ALL RIGHTS, CLAIMS AND 
REMEDIES OF BUYER AGAINST VEMCO, EXPRESS OR IMPLIED, ARISING BY LAW OR OTHERWISE, WITH RESPECT TO ANY NON-PERFORMANCE OR DEFECT IN THE 
PRODUCT OR IN ANY OTHER THING DELIVERED UNDER THIS AGREEMENT, INCLUDING BUT NOT LIMITED TO: 
(A) ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE; 
(B) ANY IMPLIED WARRANTY ARISING OUT OF COURSE OF PERFORMANCE, COURSE OF DEALING OR USAGE OF TRADE; 
(C) ANY OBLIGATION, LIABILITY, CLAIM OR REMEDY IN TORT, WHETHER OR NOT ARISING FROM THE NEGLIGENCE OF VEMCO OR ANY ASSIGNEE OF VEMCO, 

ACTUAL OR IMPUTED;  
(D) ANY OBLIGATION, LIABILITY, RIGHT, CLAIM, OR REMEDY FOR LOSS OF OR DAMAGE TO THE PRODUCT, FOR LOSS OF USE, REVENUE, OR PROFIT WITH RESPECT 

TO THE PRODUCT; OR FOR ANY OTHER DIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES; AND 
(E) VEMCO MAKES NO REPRESENTATION THAT THE PRODUCT WILL NOT INFRINGE ANY PATENT OR OTHER RIGHTS OF ANY PERSON AND BUYER AGREES TO 

INDEMNIFY VEMCO AND HOLD VEMCO HARMLESS FROM ANY AND ALL CLAIMS AND LIABILITIES WITH RESPECT TO SAME TOGETHER WITH ANY CLAIMS AND 
LIABILITIES WITH RESPECT TO ANY INFRINGEMENT OF ANY PATENT OR OTHER RIGHTS OF ANY PERSON ARISING AS A RESULT OF BUYER'S PRODUCTS, 
TECHNOLOGY, ACTIVITIES, OR OTHERWISE. 

 
LICENSE AGREEMENT 
VEMCO grants to the Buyer a limited, personal license, with no right to sub-license, to use the Intellectual Property (“IP”) and Embedded Software in the manner set out in the 
Documentation. The Embedded Software and IP are not sold to Buyer. All property rights, including Intellectual Property Rights, remain with VEMCO. All rights related to the Embedded 
Software not expressly licensed to the Buyer are reserved to VEMCO. BUYER shall not permit any person other than BUYER and its employees to use or make use of the Embedded 
Software and/or IP. BUYER shall not, and shall not permit any third party to, modify, adapt, translate, reverse engineer, decompile, disassemble, or create derivative works based on the 
Embedded Software and/or IP. This license is assigned to the Product with which you have acquired the Embedded Software and/or IP. If the Product purchased is a Transmitter product, 
be advised that the license life is equal to the operational life. 
 
EXPORT 
Products and associated materials supplied or licensed hereunder may be subject to various export laws and regulations. It is the responsibility or BUYER to comply with such laws and 
regulations. 
 
NEGOTIATED AGREEMENT 
It is fully understood by the parties that the price of the Product and other mutual agreements of the parties set forth in this agreement were arrived at in consideration of this warranty, 
SPECIFICALLY INCLUDING THE WAIVER, RELEASE AND RENUNCIATION BY BUYER SET FORTH ABOVE (DISCLAIMER AND RELEASE). 

 
 © (2011) AMIRIX Systems Inc. All rights reserved. The information contained herein includes information which 

is confidential and proprietary to AMIRIX Systems Inc. and may not be used or disclosed without prior written 
consent of AMIRIX Systems Inc. 
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1 INTRODUCTION 
 
1.1 ABOUT VEMCO 
 
VEMCO, a division of AMIRIX Systems Incorporated, is a leader in the design and manufacture of 
oceanographic research tools and systems since 1979. Located in Halifax, Nova Scotia, VEMCO's product 
line ranges from miniature acoustic transmitters and data loggers to large tracking, positioning, and 
monitoring systems. 
 
For more information on our products, please visit us at www.vemco.com. 
 
 
1.2 SYSTEM REVIEW 
 
The VR3 family of receivers are submersible, multi-channel acoustic receivers capable of identifying 
VEMCO coded transmitters.  The receivers operate on 69.0 kHz, and can decode our standard coded 
acoustic transmitters.  The VR3 family includes the VR3-UWM (Underwater modem) and the VR3-Argos. 
 
The VR3-UWM (Underwater Modem) receiver is designed to be moored underwater.  
The VR3-UWM can communicate with a modem positioned under the surface to 
receive commands and transmit data.   
 
The VR3-Argos receiver is designed to be moored at the surface of the water and 
record any VEMCO tags in the area.  It uses the Argos satellite service to transmit 
data from anywhere in the world on a regular schedule, typically once every few days.  This permits data 
analysis to begin almost immediately after deployment.  Data can also be retrieved through a service port on 
the receiver when the receiver has been retrieved from deployment. 

The  
VR3 receivers 

detect coded tags 
but not 

continuous tags. 

 
The VR3HS software functions with both the VR3-UWM and the VR3-Argos.  With the VR3-UWM 
receiver, the software allows receiver settings to be sent to the receiver, tilt angle display for deployment, 
range to receiver indication, sensor tag management, data retrieval, and creating comma delimited data files.  
With the VR3-Argos receiver, the software allows receiver settings to be sent to the receiver (before 
deployment), sensor tag management, and data retrieval (after receiver is retrieved). 
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1.3 USING THIS MANUAL 
 
This manual contains the necessary information needed to use the VR3HS software. This includes how to 
use the software; view the tilt while deploying a VR3-UWM receiver; locate a deployed VR3-UWM; input 
sensor transmitter information; and retrieve stored data.   
 
This manual is broken into major sections for easier use of the information found in the manual.  These 
sections, with a brief explanation, are listed in Table 1. 
 

Table 1:  Sections contained in this manual. 
Section Description 

Introduction Introduction to the VR3 receivers and this manual. 
Applications Details on how to use the VR3HS software with the receiver. 

Software Description of the software elements and the file types.  
Appendix Glossary and additional information. 

 
The manual refers to tags, pingers, and sensor transmitters.  The relationship these three terms have with 
each other is shown in the diagram below.  Basically, a tag is a general term referring to either a pinger  or a 
sensor transmitter. 
 
 
 TAG

PINGER 
These are tags that do not contain a 
sensor and don’t transmit data information. 

 
 
 
 
 
 
 
 
 
 
UPDATE  
(May 2008) 

It’s strongly suggested that sensor transmitter information (including slope and 
intercept) is entered in VUE software instead of in VR3HS software.  Without the 
slope and intercept in VR3HS, the created VR3 data files are compatible with VUE 
and can be imported to the VUE database (see Importing “Old” VR2 and VR3-
UWM Text data files in VUE manual).  If desired, the sensor transmitter 
information can be used in the VR3HS software but the VR3 data files will not 
contain the proper formatting to correctly interface with the VUE database. 

SENSOR TRANSMITTER 
These are tags that contain at least one 
sensor.  They transmit the sensor data. 

Don’t enter sensor 
transmitter information 
in VR3HS – use VUE 
instead.  

Load data from VR3-
UWM and import it in 
VUE software. 

 
For more information about VUE software, and to obtain a copy, see www.vemco.com/support 
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2 APPLICATIONS 
 
This section of the manual explains how to use the VR3HS software with the VR3-UWM and VR3-Argos 
receivers by tasks, or applications.  The Software section of this manual explains how to use the software by 
section. 
 
2.1 QUICK SETUP 
 
2.1.1 Quick setup for the VR3-UWM 
 
The list below gives the order of actions needed to setup and use the VR3-UWM receiver.  The steps may 
reference sections in this manual that contain more details about that step. 
 
1. Install the VR3HS software on the computer, if not already installed (see section 4.1.2). 
2. Set properties in software:  (only needs to be done on first use and if information has changed) 

a. Select the data directory to be used to store the files (see section 3.2.1.1). 
b. Select the colours to be used for the software display and the times for Status Update Period (see 

section 3.2.3.4). 
3. Install the battery in VR3-UWM receiver if applicable (see the VR3-UWM Operating manual).  The 

receiver starts recording data as soon as it is powered. 
4. Power the surface modem and physically connect it to the serial port on the computer (see the VR3-

UWM Operating manual).  
5. Perform an in-air test (see the VR3-UWM Operating manual). 
6. Deploy the surface modem (see the VR3-UWM Operating manual). 
7. Deploy the VR3-UWM receiver (see the VR3-UWM Operating manual). 
8. Use the UWM Tilt Display command to watch the tilt angle of the receiver as it is deployed (see section 

3.2.3.1). 
9. Record the physical location of the receiver with its ID number. 
10. Leave the VR3-UWM to collect data from transmitters. 
11. Return to the general location of the VR3-UWM. 
12. Deploy the surface modem (see the VR3-UWM Operating manual). 
13. Send a “Connect” command to wake the VR3-UWM modem (see section 3.1.1).  This may take a few 

minutes. 
14. Use the UWM Range Display command to locate the VR3-UWM (see section 3.2.3.2). 
15. Load the data from the VR3-UWM receiver with the Upload Logs button (see section 3.2.2.1). 
16. If the study is continuing, repeat steps 11 to 16 until the study is completed.   
17. When the study is complete, retrieve the VR3-UWM and remove the battery pack to stop the recording. 
 

 
VR3HS Software Manual  3 



 

 
2.1.2 Quick setup for the VR3-Argos 
 
1. Install the VR3HS software on the computer, if not already installed (see section 4.1.2). 
2. Set properties in software:  (only needs to be done on first use and if information has changed) 

a. Select the data directory to be used to store the files (see section 3.2.1.1). 
3. Enter sensor transmitter information (only necessary if using sensor transmitters): 

a. Open the Tag Manager window (see section 3.3). 
b. Setup the sensor transmitters being used with the receiver (see section 3.3.2.1.1). 
c. Transfer the sensor transmitter information to the VR3 receiver file (see section 2.2.10). 

4. Install the battery in VR3-Argos receiver if applicable (see the VR3-Argos Operating manual).  The 
receiver starts recording data as soon as it is powered. 

5. Deploy the VR3-Argos receiver (see the VR3-Argos Operating manual). 
6. Leave the VR3-Argos to collect data from transmitters. 
7. Use an Internet connection to retrieve compressed data via the Argos system (see the VR3-Argos 

Operating manual). 
8. When the study is complete: 

a. Retrieve the VR3-Argos receiver. 
b. Connect the computer running the VR3HS software directly to the receiver’s service port. 
b. Load the raw data from the VR3-Argos receiver with the Upload Logs button (see section 3.2.2.1). 
c. Deactivate the receiver (see the VR3-Argos Operating manual). 
d. Remove the battery pack to stop the recording. 
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2.2 HOW DO I … 
 
The “How Do I …” section of the manual lists the steps necessary to perform particular actions with the 
VR3 receivers and the VR3HS software.  The actions are listed alphabetically for easier referencing.  Use 
the Quick Setup (section 2.1) to use the VR3HS software in a step-by-step manner.  
 
 
2.2.1 Add a coded sensor transmitter 
 
Follow the steps listed below to enter a coded sensor transmitter 
in the VR3HS software (see section 3.3.2.1.1). 
 
1. Open the Tag Manager window by selecting Tag Manager 

in the Tools menu, or click on the appropriate speed button. 
2. Open a resource file, if desired (see section 3.3.1.2). 
3. Click the “Coded256Sensor” located in PC Managed Setup (left side of window).  The “Add Coded 256 

Sensor” section will appear in the bottom left corner of the Tag Manager window. 
4. Enter the following information in the correct boxes.  The boxes are labelled and the information is 

found in the Transmitter Specification manual shipped with the sensor transmitter. 
a. Serial number 
b. Frequency in kilohertz (kHz) 
c. Coded map – select from the default maps in the pull-down list. 
b. ID number 
c. Codespace (eg. A69-1105) 
d. Sensor type – temperature or depth 
e. Slope 
f. Intercept 

5. Verify that the information was entered correctly. 
6. Click the “Update” button at the bottom of the window.  The tag will appear in the list in the PC 

Managed Setup section of the window. 
7. Save the resource file, if desired (see section 3.3.1.3). 
8. Transfer the tag setup to the VR3 receiver (see section 2.2.10).   
 
 
 
2.2.2 Communicate Using the Underwater Modem (VR3-UWM only) 
 
When the underwater modem is used for communication with the VR3-UWM, the steps below must be 
followed (see section 3.1.1): 
 
1. Setup the surface modem (see the VR3-UWM Operating manual). 
2. Physically connect the surface modem to the serial port (com port) on the computer and make note of 

the serial port number. 
3. Open the VR3HS software. 
4. Select the com port number from the drop-down list in the bottom left corner of the software window 

(see picture in section 3.1.1). 
5. Select “UWM” from the drop-down list to the right of the com port list (see picture in section 3.1.1).   

Do not enter slope and intercept 
information if data will be imported into 
VUE software.  For the VUE software to 
properly post-process data, slope and 
intercept information must be entered 
into VUE and not in VR3HS software. 



 

6. Select the receiver ID number from the pull-down list.  If the receiver has never been physically 
connected to this computer, the ID number will need to be entered in the box using the computer 
keyboard. 

7. Enter the depth (in meters) at which the VR3-UWM will be deployed.  This is 
necessary to identify the correct surface range to the VR3-UWM receiver (see section 
3.2.3.2) but is not required for communication. 

WARNING 
Always 

operate the 
surface 

modem in 
low power 
mode when 
used in air. 

8. Add any notes as desired.  This information will be stored in the log and seen in the 
data file (see section 3.4.1). 

9. Click the “Connect” button.  A window will appear asking if the modem is to be used 
in high power mode (see section 3.1.1). 

10. Click the “Yes” button if the surface modem is in water and click “No” if the surface 
modem is in air (this occurs during the in-air test; details are in the VR3-UWM 
Operating manual).   

 
The software will then perform the tasks explained in the list below and will report the comments included 
in the quotation marks on the status line at the bottom of the software window. 
 
• The status line at the bottom of the software window will report “Detecting UWM surface unit...” to 

indicate that the software is connecting with the surface modem.   
• After a few seconds, the message “Connecting (attempt #1)...” appears in the status line for 10 seconds 

while the surface unit checks to see if the bottom modem (on the receiver) is ready to receive.  If it isn’t 
ready, then the surface unit sends a “wake up” command for two minutes and the status line reports 
“Sending wakeup signal...”. 

• The surface unit then makes a second attempt to connect with the receiver’s modem and the status line 
reports “Connecting (attempt #2)...”.  The process of sending wake up messages and attempting to 
connect continues until connection is made with the receiver or the attempt is manually aborted. 

• When the communication connection between the surface and bottom units is made, the software 
requests basic receiver settings from the receiver and the status line at the bottom of the window reports 
“Interrogating VR3 ID= ?,...”, where the ? represents the ID number.  This takes approximately 20 
seconds, after which the status line reports “Connected”. 

 
Note: Connections will take longer in noisy or long-distance conditions. 
 
 
2.2.3 Copy configurations from one computer to another 
 
If more than one computer is used in a study for communicating with VR3 receivers, it may be convenient to 
copy configurations between computers.  The VR3HS application configuration file (VR3HSSetup.xml) 
contains all the general application settings, receiver configurations, and sensor transmitter setups that the 
software uses.  This configuration file may be copied from one computer to another in order to setup the 
VR3HS software identically on each.  This will overwrite all settings on the recipient computer.  
Alternatively, individual receiver configurations may imported from one computer to another using the 
procedure in section 3.2.1.3.   
 
To copy the configurations, follow the steps below. 
 
1. Make sure the VR3HS software is closed on the first computer. 
2. Copy the VR3HSSetup.xml file from the first computer to the second computer and overwrite the 

second computer’s VR3HSSetup.xml file. 
3. Open the VR3HS software on the second computer. 
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2.2.4 Deploy a VR3-UWM 
 
This information is also available in section 3.2.3.1. 
 
1. Physically connect the surface modem to the computer running the VR3HS software. 
2. Suspend the VR3-UWM from ropes so it hangs vertically with the transducer pointing up.   
3. Select the VR3 ID number from the list of receivers at the bottom of the software window.  If the correct 

receiver number is not in the pull-down list, highlight an ID number in the box, enter the number on the 
computer keyboard, and press Enter. 

4. Click the “Connect” button in the bottom left corner of the software window.  The surface modem will 
then attempt to wake up the receiver, request its status, and will numerically report the slant range, 
surface distance, and receiver’s tilt angle on the right side of the window. These values will be 
periodically updated, at the rate selected for the Status Update Period (see section 3.2.3.4). 

5. Select the UWM Tilt Display command from either the speed buttons or from the Tools menu.  The 
software window will display the circular level display as shown here.   

6. Verify that the dot (shown here as magenta) is in the center of the circle or very 
close to it.  The center of the circle represents the vertical.  Movement of the dot 
indicates the receiver is now at an angle and gives the general direction in which 
the receiver has tipped.   

7. Deploy the VR3-UWM receiver (see the VR3-UWM Operating manual).    
8. Watch the location of the dot in the circular level display as the receiver is 

lowered through the water to make sure it remains in the center of the circle.  If 
the dot has moved drastically, then reposition the receiver until it is as close to the center as possible.  
This is important for communication with the receiver. 

9. Place the receiver in its moored location so the dot is as close to the center of the circle as possible.  If 
the angle is too great, then reposition the receiver so the angle decreases.  This is very important for 
modem communication.   

 
 
2.2.5 Edit a sensor transmitter 
 
Sensor transmitters that have already been entered can be edited.  Follow the steps below to edit an existing 
sensor transmitter (see section 3.3.2.1.1). 
 
1. Highlight the desired tag in the PC Managed Setup list (left side of Tag Manager window).  The 
information already entered about that tag is displayed in the bottom left corner of the window but is not 
accessible for editing. 
2. Click the “Edit” box in the bottom left corner of the window. 
3. Edit the tag information as needed. 
4. Click the Update button. 
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2.2.6 Load data from a VR3 receiver 
 
Data that has been received and stored in the VR3-UWM receiver’s memory is loaded to the computer by 
following the steps below. 
 
1. Establish a communication connection with the VR3 receiver (see section  3.1.1 for underwater 

communication or section 3.1.2 for serial port communication).  
2. Select the Upload Logs command (see section 3.2.2.1) from either the speed buttons or from the VR3 

menu.  A VR3 upload report will appear with the amount of memory used and the expected time 
required to load the memory to the computer. 

3. Select if you’d like to load the entire log stored in memory or just the new entries stored since the last 
upload. 

4. For VR3-UWM receivers, leave the “Use Data Compression” box clicked. Compression should only be 
disabled as a last resort for recovering corrupted data   

5. Place a check mark in the “View uploaded log” box by clicking it with the mouse arrow if you’d like to 
view the data as soon as it’s uploaded.  If this isn’t selected, the data can be viewed by selecting Display 
Logs in the File menu (see section 3.2.1.2). 

6. Click the “Upload” button in the bottom right corner of the VR3 Upload window.  The VR3 Log Upload 
window will appear to report on the progress of the upload and to allow the upload process to be 
aborted. 

7. View the data file by using the Display Logs command (see section 3.2.1.2), if desired. 
 
 
2.2.7 Locate a deployed VR3-UWM 
 
A deployed VR3-UWM can be located acoustically when the surface modem is within 350 meters of the 
VR3-UWM and within a 120 degree cone.  This is performed by following the steps below. 
  
1. Move to the general area the VR3-UWM is known to be in.  The size of this general area depends on the 

acoustic conditions and the depth at which the receiver was deployed.  
2. Deploy the surface modem, if not already deployed. 
3. Select the UWM Range Display command (see section 3.2.3.2) from either the speed buttons or from the 

Tools menu.  The left side of the software window will change to a target range circle (see section 
3.2.3.2). 

4. Select the VR3 ID number from the list of receivers.  If the correct receiver number is not in the pull-
down list, highlight an ID number in the box, enter the number on the computer keyboard, and press 
Enter. 

5. Click the “Connect” button in the bottom left corner of the software window.  The surface modem will 
then attempt to wake up the receiver, request its status, and will numerically report the slant range, 
surface distance, and receiver’s tilt angle on the right side of the window.  The “Surface Distance” value 
will also be represented by the “Current Location” ring on the target range circle. These values will be 
periodically updated, at the rate selected for the Status Update Period (see section 3.2.3.4). 

6. Move the boat until the “Surface Distance” decreases, making the “Current Location” ring shrink, and 
continue to move the boat until the ring is inside the “Target Area” circle.   
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2.2.8 Open a Resource file 
 
Open a resource file (see section 3.4.3) to retrieve the sensor tag setups.  A resource file is opened by 
following the steps below. 
 
1. Select Tag Manager in the Tools menu (see section 3.3), or with the speed button. 
2. Select Open in the File menu of the Tag Manager window (see section3.3.1.2). 
3. Select the desired file in the Open window.  It may be necessary to move to a different directory, 

depending on where the resource file was saved. 
4. Click the “Open” button or double click the file name.   
 
When a resource file is open, the sensor tag setups contained in that file are shown in the PC Managed Setup 
half (left side) of the Tag Manager window. 
 
 
2.2.9 Search for a Deployed VR3-UWM 
 
If the address (ID number) of a deployed VR3-UWM receiver is unknown, the VR3HS software is capable 
of searching for it within the acoustic range of the underwater modem for a deployed VR3-UWM receiver.  
This is accomplished by following the steps listed below. 
 
1. Setup the surface modem (see the VR3-UWM Operating manual). 
2. Physically connect the surface modem to the serial port (com port) on the computer and make note of 

the serial port number. 
3. Open the VR3HS software. 
4. Select the com port number that the surface modem is connected to from the drop-down list in the 

bottom left corner of the software window (see picture on previous page). 
5. Select “UWM” from the drop-down list to the right of the com port list (see picture below).   
6. Select “Search” from the pull-down list.   
7. Click the “Connect” button.  A window will appear asking if the modem is to be used in high power 

mode (see section 3.1.1). 
8. Click the “Yes” button if the surface modem is in water and click “No” if the surface modem is in air 

(this occurs during the in-air test, see the VR3-UWM Operating manual).  WARNING: Always operate 
the surface modem in low power mode when being used in air. 

9. Enter the ID number(s) of the receivers involved in the search and click the “OK” button.  Multiple ID 
numbers can be entered by using commas or dashes.  For example, entering “3, 6, 9-12, 20” will search 
for ID numbers 3, 6, 9, 10, 11, 12, and 20.   
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The software will then perform the tasks explained in the list below and will report the comments included 
in the quotation marks on the status line at the bottom of the software window. 
 
• The status line at the bottom of the software window will report “Detecting UWM surface unit...” to 

indicate that the software is connecting with the surface modem.   
• After a few seconds, the message “Sending global wakeup signal...” will appear in the status line and 

will continue for two minutes. 
• The software then tests for the first receiver ID in the list (see Step 10) for 10 seconds and reports 

“Testing VR3 ID = ?,” in the status line, where the ? represents the receiver’s ID number.  If this 
receiver doesn’t reply to the software then the software moves on to the next receiver ID in the list and 
tests for 10 seconds.  This continues until a receiver is found or the process is aborted. 

• When a receiver id is found, the software attempts a connection and the status line reports  
• “Found VR3 ID = ?. Connecting (attempt #1)...”. 
• When the communication connection between the surface and bottom units is made, the software 

requests basic receiver settings from the receiver and the status line at the bottom of the window reports 
“Interrogating VR3 ID= ?,...”.  This takes approximately 20 seconds, after which the status line reports 
“Connected”. 

 
Note: Connections will take longer in noisy or long-distance conditions. 
 
 
2.2.10 Transfer the PC Managed Setup list to the Receiver Setup list 
 
The tag information entered in the PC Managed Setup half of the Tag Manager window (see section 3.3) 
must be transferred to the Receiver Setup half of the window to be used with the VR3-UWM receiver.  
Follow the steps listed below to perform such a transfer. 
 
1. Open the Tag Manager window (see section 3.3). 
2. Enter the tag information by either entering it in the window (see section 3.3.2.1.1) or by opening a 

previously saved resource file (see section 3.3.1.2). 
3. Select the desired tag in the PC Managed Setup list (left half of window) by clicking it once with the 

mouse. 
TIP:  To select more than one tag at once, select the first tag then hold the Control key on the computer’s 
keyboard while you select the other tags with the mouse arrow.  Press the Shift key instead to select 
blocks of tags.  

4. Click the right-pointing arrow located in the middle of the Tag Manager window.  The setup for the 
selected tag(s) is transferred to the Receiver Setup list (right half of window) and stored for use with the 
VR3-UWM. 

 
 
2.2.11 Use multiple computers and multiple VR3 receivers 
 
When several computers with installations of the VR3HS software are used for the deployment of several 
VR3 receivers, the receiver details are recorded in VR3HSSetup.xml files on the individual computers.  The 
steps listed below explain one method of consolidating those files and using it with all the computers. 
 
1. Deploy the VR3 receivers using several computers with the VH3HS software installed.   
2. Make a “master” computer: 
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a. Copy the VR3HSSetup.xml file from each deployment computer to a single 'master' computer.  
NOTE:  Change the name of the file to prevent the files from being overwritten by the next 
VR3HSSetup.xml file.  The extension must remain “.xml”. 

b. Make a backup copy of the VR3HSSetup.xml files.   
c. Use Add/Remove Receivers (see section 3.2.1.3) to import the receiver setup from the individual 

files into the VR3HS software on the “master” computer. 
d. If necessary, use the VR3HS Tag Manager on the master computer to add sensor transmitter 

information (see section 3.3.2.1.1). 
e. Save the master VR3HSSetup.xml file by exiting the VR3HS software.  The master computer's 

VR3HSSetup.xml file now contains configurations for all the receivers and sensor transmitters in 
the study.   

f. Make a backup copy of the master VR3HSSetup.xml file. 
3. Copy the master VR3HSSetup.xml file to all computers that will be used for log retrieval.   
4. NOTE: Overwrite the individual VR3HSSetup.xml files on each computer with the master 

VR3HSSetup.xml file. 
5. Repeat Steps 2 and 3 after each log retrieval operation to consolidate the updated status of all receivers. 
 
 
2.2.12 View a data file within VR3HS software 
 
A data file is viewed in the VR3HS software by following the steps listed below (see section 3.2.1.2). 
 
1. Select Display Logs (see section 3.2.1.2) in the File menu.  
2. Select the desired data file from the list shown in the Open window.  The Open window will 

automatically list all log files located in the directory selected in Choose Directory (see section 3.2.1.1).  
If the data file is in another directory, then move to that directory within the Open window.  

3. Click the “Open” button in the bottom right corner of the window. 
 
The data file is displayed in the Log Viewer window as shown in section 3.2.1.2.  No changes can be made 
to the data file from within the VR3HS software. 
 
NOTE: Data files can also be viewed with a text editor or be imported into a spreadsheet program allowing 
comma delimited files. 
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2.2.13 Update the Coded Map 
 
To update your VR3 receiver to the new coded map, follow the instructions below. 
 
1. Establish communication between the VR3 receiver and VR3HS program (see 

section 3.1).  
Reminder: Choose the Low Power mode if you’re communicating using surface modem in air. 

 
2. Select VR3 Settings from the VR3 menu.  The VR3HS software uploads the current settings from the 

VR3 receiver, which will take some time.  The VR3-UWM Settings window opens after the VR3 settings 
have been uploaded. 

 
3. Click the box next to “Show Map Details” and the 

information identifying which map is currently loaded in 
the VR3 will appear in a section of the window.  If this is 
not the desired map, then continue with this procedure as 
listed below. 

 
4. To select a different map, choose the correct map in the 

Map drop-down list.    
 
5. Click the “Apply” button in the VR3 Settings window.   

The Erase Logs window will appear (see section 3.2.2.2).  
Click the “Yes” box (check mark appears) and then “OK” 
to erase the log.  The changes will then be made to the 
settings.  If the log is not erased, then the changes to the 
settings will not take affect.   
 
After the log is erased, the VR3 Settings Upload window reports “Storing VR3 settings” and the 
approximate time remaining in the process.  When the VR3 Settings Upload window closes, the new 
coded map is active in the VR3 receiver. 

 
 
 
 

NOTE:  The 
user must be in 
Administrator 
mode to modify 
a map. 



 

 

3 SOFTWARE 
 
 
This section of the manual explains the VR3HS software by section.  The Application section of this manual 
explains the software by tasks.  The software has four menu selections: File menu, VR3 menu, Tools menu, 
and Help menu.  Detail about each of these menus is found in section 3.2. 
 
 
 
 FILE 

Choose Directory 
Display Logs 
Add/Remove Receivers 
Exit 

VR3 

Upload Logs 
Erase Logs 
VR3 Settings 

TOOLS 

UWM Tilt Display 
UWM Range Display 
Tag Manager  
Options 

HELP 

VR3HS Help 
About 

VR3HS Menu Structure

 
 
 
 
 
 
 
This software is used with both the VR3-UWM and the VR3-Argos receivers.  Most functions are similar 
for both receivers and will be described together.  One significant difference is that the VR3-UWM has two 
methods of communication with the VR3HS software (through the underwater modem or through the 
service port) and the VR3-Argos has only one (through the service port). 
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3.1 COMMUNICATION 
 
Communication between a VR3 receiver and the VR3HS software occurs through the service port.  The 
VR3-UWM receiver can also communicate with the VR3HS software through the underwater modem, 
which can occur when the receiver is in air or water.  Communication through the service port can only 
occur when the receiver is in air. 
 
The connection status lights, located in the bottom left corner of the software window, indicate the status of 
communication between the software and the VR3, regardless of the method of communication (underwater 
modem or service port).  When the software is not in communication with the receiver, and is 
not attempting to be in communication, the red connection status light on the far left is lit.  
During attempts by the software to establish, or re-establish, communication with the receiver, 
the yellow connection status light flashes.  When communication is established, the green 
connection status light on the far right flashes.  For illustration purposes, all three lights are 
shown here, although only one light can be seen at a time in the software. 
 
The Update Timer, immediately to the right of the connection status lights, indicates the length of time (in 
minutes and seconds) since the last successful VR3 status update.  A status update consists of the VR3 tilt 
angle and the slant range measurement, and occurs approximately at the rate selected in the Options window 
(see section 3.2.3.4).  When the time between status updates has been too long, the software will 
automatically attempt to acoustically re-connect with the VR3-UWM.  The software will continue to attempt 
to re-connect until the “Abort” button is clicked.   
 
The status line, to the right of the Update Timer, reports the status of the communication between the 
software and the receiver.  For example, the status line reports the attempt number when communication is 
being attempted, and reports “Connected” when the attempt is successful. 
 
 
3.1.1 Using the Underwater Modem 
 
When the underwater modem is used for communication with the VR3-UWM, the steps below must be 
followed: 
 
1. Setup the surface modem (see the VR3-UWM Operating manual). 
2. Physically connect the surface modem to the serial port (com port) on the computer and make note of 

the serial port number. 
3. Open the VR3HS software. 
4. Select the com port number from the drop-down list in the bottom left corner of the software window 

(see picture in section 3.1.1). 
5. Select “UWM” from the drop-down list to the right of the com port list (see picture in section 3.1.1).   
6. Select the receiver ID number from the pull-down list.  If the receiver has never been physically 

connected to this computer, the ID number will need to be entered in the box using the computer 
keyboard. 

7. Enter the depth (in meters) at which the VR3-UWM will be deployed.  This is necessary to identify the 
correct surface range to the VR3-UWM receiver (see section 3.2.3.2), however is it not required for 
communication. 

8. Add any notes as desired.  This information will be stored in the log and seen in the data file (see section 
3.4.1). 

9. Click the “Connect” button.  A window will appear asking if the modem is to be used in high power 
mode (see section 3.1.1). 

 
14  VEMCO – a division of AMIRIX Systems 



 

10. Click the “Yes” button if the surface modem is in water and click “No” if the surface modem is in air 
(this occurs during the in-air test; details are in the VR3-UWM Operating manual).   

 
The software will then perform the tasks explained in the list below and will report the 
comments included in the quotation marks on the status line at the bottom of the 
software window. 
 
• The status line at the bottom of the software window will report “Detecting UWM 

surface unit...” to indicate that the software is connecting with the surface modem.   
• After a few seconds, the message “Connecting (attempt #1)...” appears in the status 

line for 10 seconds while the surface unit checks to see if the bottom modem (on the receiver) is ready to 
receive.  If it isn’t ready, then the surface unit sends a “wake up” command for two minutes and the 
status line reports “Sending wakeup signal...”. 

• The surface unit then makes a second attempt to connect with the receiver’s modem and the status line 
reports “Connecting (attempt #2)...”.  The process of sending wake up messages and attempting to 
connect continues until connection is made with the receiver or the attempt is manually aborted. 

• When the communication connection between the surface and bottom units is made, the software 
requests basic receiver settings from the receiver and the status line at the bottom of the window reports 
“Interrogating VR3 ID= ?,...”, where the ? represents the ID number.  This takes approximately 20 
seconds, after which the status line reports “Connected”. 

 
Note: Connections will take longer in noisy or long-distance conditions. 
 
 
3.1.2 Using the Service Port 
 
The VR3HS software can connect directly to the VR3 service port on both the VR3-UWM and the VR3-
Argos.  Although the location of the service port is different on the two receiver types (see the respective 
operating manuals), how the VH3HS software connects is the same.   
 
To communicate with a VR3 through the service port, follow the steps below: 
 
1. Physically connect the computer’s serial port to the service port on the receiver and make note of the 

serial port number (needed for step 4). 
2. Power the receiver by connecting the battery to the receiver (see the Operating manual).  The battery 

doesn’t have to be inside the receiver case for communication in air. 
3. Open the VR3HS software. 
4. Select the com port number from the drop-down list in the bottom left corner of the software window 

(see picture below). 
5. Select “Service Port” from the drop-down list to the right of the com port list (see picture below).   
6. Click the “Connect” button.   
 
When the connection is made, the green communication light will be seen in the bottom left corner of the 
window (see section 3.1).   When the VR3-Argos receiver is connected, the message “VR3-ARGOS 
Connected” will appear in the middle of the window. 

WARNING 
Always 

operate the 
surface 

modem in 
low power 
mode when 
used in air.
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3.2 MENU SELECTIONS 
 
3.2.1 File menu 
 
3.2.1.1 Choose Directory 
 
All information uploaded from the VR3 receiver through the VR3HS software will be stored in the directory 
selected using Choose directory.  Selecting Choose directory will open the Select Directory window shown 
below.  Select the drive from the list in the “Drives” box and the desired directory in the “Directories” box.  
The directory listed in the “Directory Name” box at the top of the window will be used as the data directory.  
 
TIP:  A new directory can be created within 
the selected directory by typing a back-slash 
(\) at the end of the directory location and 
adding the name of the new directory.   
 
 
 
 
 
 
 
 
 
 
3.2.1.2 Display Logs 
 
Select Display Logs in the File menu to reveal the Open window and allow the selection of a data file (see 
section 3.4.1).  Once the desired data file has been selected, click the Open button to view the file.  The 
selected file will open in the Log Viewer, shown below.  Data files cannot be altered when viewed within 
the VR3HS software. 
 
 
 
 
 
 
 
 
 
 
 
 
The Display Logs command is repeated in the File menu of the Log Viewer window to allow a different log 
file to be opened from within the Log Viewer window without having to close the window. 
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3.2.1.3 Add/Remove Receivers 
 
The Add/Remove Receivers feature of the software is used with multiple VR3 receivers and multiple 
computers.  If only one computer is being used to communicate with the VR3 receivers, then this feature is 
not needed. 
 
The VR3HS software automatically stores all it's settings in the VR3HSSetup.xml file (see section 3.4.4).  
The receiver configurations from this file can be imported into another VR3HSSetup.xml file on another 
computer by following the steps listed below. 
 
1. Copy the VR3HSSetup.xml file containing the desired receiver configuration(s) to a temporary directory 

on the new computer.  NOTE: Copying the file directly to the same folder as the software will overwrite 
the setup file on the new computer. 

2. Run the VR3HS software on the new computer. 
3. Select Add/Remove Receivers to open the Receiver Management window (see below). 
4. Click the “Open File” button.  The Open window will appear. 
5. Locate the VR3HSSetup.xml file from Step 1 and open it (click the “Open” button).  The receiver ID 

numbers and related notes will be listed in the right half of the Receiver Management window.  The 
name of the file is shown above the list of receivers. 

6. Use the left mouse button to click on the desired receiver ID number and drag it to the “Current 
Receiver List” half of the window.  Release the mouse button when the mouse arrow is over the left half 
of the window.  The receiver ID number and notes are now listed in the “Current Receiver List”.  The 
receiver ID 15 was imported in the sample window below. 

7. Click the “Done” button when all the desired receiver configurations have been imported. 

 
 
 
3.2.1.4 Exit 
 
This Exit command closes the VR3HS software.  This is the same as clicking the X in the top right corner of 
the window. 
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3.2.2 VR3 menu 
 
3.2.2.1 Upload Logs 
 
When the Upload Logs command is selected, the software will request a report from 
the VR3 receiver before uploading the data.  The report contains the percentage of 
memory used and the percentage of memory that was last uploaded.  It also contains 
the time the last detection was received, and the number of detections, pings, and syncs 
for each frequency.  The VR3 Upload window below contains a sample upload report.       
 
The log can be uploaded entirely (everything in memory) or partially (everything stored since the last 
upload).  The selection is made near the bottom left corner of the VR3 Upload window (see below).  Click 
the “Upload entire log” radio button to load everything in the receiver’s memory.  If you just want the new 
entries since the last upload, then click the “Upload new entries” radio.  The amount of memory involved for 
both the entire log and the new entries is given to the right of the selections (see the sample window below).  
The estimated time required to upload the data based on the amount of memory being loaded is also given at 
the bottom of the window. 
 
When the Upload Logs command is given, the VR3 receiver’s memory is uploaded to the computer, stored 
in a log file (see section 3.4.2), and converted to data files (see section 3.4.1). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
After the “Upload” button is selected, the VR3 Log Upload window (shown on next page) will appear to 
report on the progress of the upload and to allow the upload process to be aborted.  The bar graph at the 
bottom of the window is a visual representation of the amount of the memory that has been loaded.  The 
colour of the bar indicates the rate at which the memory is transferred: blue indicates a conservative transfer 
rate, orange indicates an aggressive transfer rate, and red indicates very aggressive transfer rate.  The 

A step-by-step 
instruction for 
loading data 
from a VR3-
UWM is given in 
section 2.2.6). 

Data compression is
available during an 
upload for the VR3-
UWM receiver.  
leave this enabled.
the VR3-Argos re
save-by-exception data 
is only available throu
the Argos downlo
the VR3-Argos 
Operation manual for 
more information). 

 

Always 
  For 

ceiver, 

gh 
ad (see 
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transfer rate changes as needed based on the acoustic conditions.  When the VR3 is connected directly to the 
computer through the service port, the bar graph will be blue. 
 
 
 
 
 
 
 
 
If communication is lost during an upload, the upload will continue where it left off as soon as 
communication is re-established.  Nothing needs to be done to resume the upload processes.  If an upload is 
aborted before all the log has been uploaded, the option is presented to save the part of the log that was 
uploaded.  If the partial log is saved, using the “Upload new” command with the next upload will retrieve 
the remains of the log. 
 
 
3.2.2.2 Erase Logs 
 
Data stored in the VR3 receiver can be erased using the Erase Logs 
command.  When the command is selected, the Erase Logs window, 
shown here, appears to verify that the data should be erased.  The “Yes” 
box must contain a check mark (as shown) when the OK button is 
clicked or the data won’t be erased.  This protects the data from
accidentally erased.  

 being 

 
NOTE:  Erase Logs is only available in the Administrator mode (see section 3.2.4.2). 
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3.2.2.3 VR3 Settings… 
 
3.2.2.3.1 VR3-UWM Settings 
 
When the VR3-UWM Settings command is selected, the software requests the status of the VR3-UWM.  The 
information displayed in the VR3-UWM Settings window, shown below, includes the model number, ID 
number, battery voltage, and time from the receiver.  NOTE:  The Erase Logs window appears (see section 
3.2.2.2) after the “Apply” button is selected to erase the log before the changes are made to the settings.  If 
the log is not erased, then the changes to the receiver’s settings will not take affect. 
 
The VR3-UWM Settings window also allows the Coded Map to be modified and the VR3-UWM clock to be 
set to either local time or UTC. 
 
The VR3-UWM receiver’s Coded Map setup allows the receiver to correctly identify coded tags from the 
acoustic pings received.  This setup is only changed on direction from VEMCO and with a new setup file.   
 
To update your VR3 receiver to the new coded map, 
follow the instructions below. 
 
1. Establish communication between the VR3 receiver 

and VR3HS program (see section 3.1).  
Reminder: Choose the Low Power mode if you’re 
communicating using surface modem in air. 

 
2. Select VR3 Settings from the VR3 menu.  The VR3HS 

software uploads the current settings from the VR3 
receiver, which will take some time.  The VR3-UWM 
Settings window opens after the VR3 settings have 
been uploaded. 

 
3. Click the box next to “Show Map Details” and the 

information identifying which map is currently loaded 
in the VR3 will appear in a section of the window.  If 
this is not the desired map, then continue with this 
procedure as listed below. 

 
4. To select a different map, choose the correct map in the Map drop-down list.    
 
5. Click the “Apply” button in the VR3 Settings window.   The Erase 

Logs window will appear (see section 3.2.2.2).  Click the “Yes” box 
(check mark appears) and then “OK” to erase the log.  The changes 
will then be made to the settings.  If the log is not erased, then the 
changes to the settings will not take affect.   
 
After the log is erased, the VR3 Settings Upload window reports “Storing VR3 settings” and the 
approximate time remaining in the process.  When the VR3 Settings Upload window closes, the new 
coded map is active in the VR3 receiver. 

 
 

The Erase Logs window 
appears after the “Apply” 
button is selected to erase the 
log before changes are made 
to the receiver’s settings. 

NOTE:  The user must be in 
Administrator mode to modify a map. 



 

The VR3-UWM receiver’s internal time can be set to correspond with the local time (computer’s clock) or 
to UTC time (the computer’s clock with the appropriate offset).  This is done by first clicking the desired 
“Set To” button, either the “Set To Local Time” button or the “Set To UTC” button.  The date and time in 
the “Time” box will change to show what the time 
will become.  The colour of the text will also change 
to red (see sample window below).  The change 
isn’t made in the receiver until the “Apply” button 
in the top right corner of the window is clicked and 
the log is erased (click “Yes” and OK).   
 
If a “Set to” button has been clicked but the 
date/time isn’t what you want, then click the 
“Cancel” button the exit the VR3-UWM Settings 
window without making any changes to the 
receiver’s settings. 
 
 
3.2.2.3.2 VR3-Argos Settings 
 
When the VR3-ARGOS Settings command is selected, the software requests the status of the VR3-Argos 
receiver.  The information displayed in the VR3-Argos Settings window, shown below, includes the model 
number, ID number, battery voltage, and time from the receiver. 
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The VR3-UWM receiver’s Coded Map setup allows the receiver to correctly identify coded tags from the 
acoustic pings received.  This setup is only changed on direction from VEMCO and with a new setup file.  
Follow the steps listed below to change the coded map of the receiver. 
 

1. Establish communication between the VR3 receiver and VR3HS program (see section 3.1).  
Reminder: Choose the Low Power mode if you’re communicating using surface modem in air. 

 
2. Select VR3 Settings from the VR3 menu.  The VR3HS software uploads the current settings from the 

VR3 receiver, which will take some time.  The VR3-UWM Settings window opens after the VR3 
settings have been uploaded. 

 
3. Click the box next to “Show Map Details” and the information identifying which map is currently 

loaded in the VR3 will appear in a section of the window.  If this is not the same as the new map, 
then continue with the procedure listed below. 

 
4. To select a different map, choose the correct map in the Map drop-down list.  If you need to change 

the time format of the VR3 clock you must do it in this window. 
 

5. Select "Apply" to program the VR3 with the selected map.  The data in the VR3 must be erased 
before the receiver is programmed.  The window below appears to confirm the erasing of the files.  
Click a checkmark in the "Yes" box and then click the OK button to proceed with the programming 
of the VR3-Argos. 

 
NOTE:  VR3-Argos Settings can only be applied (sent to the receiver) while in the Administrator mode (see 
section 3.2.4.2). 
 
 
Logging and ARGOS Transmission Enabled 
 

When the Logging and ARGOS Transmission Enabled box contains a check mark, the VR3-Argos will 
log data and will transmit it to the Argos system when enough data is present for transmission (see 
“Argos Transmit Interval” below).  This must be selected before the VR3-Argos is deployed. 
 
NOTE:  If you want to log data without transmitting it to the Argos system, set the “Argos Stop Date” to 
the current date. 

 
Test Argos 
 

The “Test Argos” box, when selected, starts Argos transmissions for testing purposes, regardless of the 
programmed schedule. 
 
It takes a few minutes before the first transmission takes place. Transmissions will continue until the end 
of the current UTC day, stopping a few minutes before midnight UTC. Once the VR3-Argos stops the 
test transmissions, it reverts to the previously programmed schedule.  The test transmissions can be 
stopped at any time by deactivating the unit (leave it deactivated for at least one repetition period to 
ensure it actually turns off). 
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Argos Transmit Interval 
 

The Argos Transmit Interval is the minimum and maximum number of days between Argos 
transmissions. 
 
The minimum number of days limits data cost. For example, a setting of 1 allows Argos transmissions 
every day, if necessary. A setting of 2 limits Argos transmissions to every second day, and so on. If cost 
is not critical, set minimum to 1. 
 
The maximum number of days ensures you receive a transmission every so often. For example, setting 
the maximum to 5 will cause the unit to transmit at least every 5 days, even if there is not enough data to 
warrant it. 
 
Within the minimum and maximum limits, the VR3-Argos will only transmit as often as necessary to 
transfer the accumulated data. 

 
Argos Stop Date 
 

The Argos Stop Date is the date when the unit will stop sending Argos transmissions. The purpose of 
this function is to accommodate studies where funding for the Argos data service is no longer available 
after a certain date.  The VR3-Argos will continue to collect and store data internally after the date has 
elapsed, but it will no longer transmit. 
 
Clicking the down-arrow next to the date will open the calendar (see previous page) to allow the desired 
stop date to be selected.  Using the two arrows in the top corners of the calendar will move the calendar 
from month to month. 

 
GPS Update Interval 
 

The GPS Update Interval is the desired time interval between GPS updates. Each time a GPS update is 
performed, the internal clock is resynchronized to GPS time, and the location is stored as a data record. 
 
A setting of 12 to 24 hours is recommended. A short time will provide more frequent GPS location 
records but has no significant impact on timing (the VR3-Argos can go many days without an update 
and still maintain adequate time synchronization). The additional location records will occupy space in 
the Argos data transmissions, so you should not set the interval shorter than necessary.  
 
The VR3-Argos has a weekly GPS "power budget" to limit power consumption. If you update too 
frequently (depends on how long the updates take to detect satellites), the budget may be used up and 
the GPS will not be used at all for the rest of the week. 

 
Absent Time 
 

The Absent Time controls the data compression algorithm. When a given tag is first detected, a new data 
record is opened. As long as the VR3-Argos continues to detect that tag, the record remains open (up to 
a limit). If the tag is not detected for more than the Absent Time, the VR3-Argos assumes that tag has 
left the area, closes the data record, and stores it.  A longer Absent Time results in less data records 
being generated, but brief absences are ignored.  
  
The VR3-Argos will automatically close records that have been open for more than a predetermined 
period, or when it is necessary for internal reasons. 
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3.2.3 Tools Menu 
 
3.2.3.1 UWM Tilt Display (VR3-UWM only) 
 
The VR3-UWM must be deployed vertically with the bottom transducer pointing up so the bottom 
underwater modem can communicate with the surface modem.  To ensure the VR3-UWM is deployed in the 
correct position, the vertical angle of the receiver is displayed on the computer screen.  The deployment 
process is listed below with the deployment screen.   
 
1. Physically connect the surface modem to the computer running the VR3HS software. 
2. Suspend the VR3-UWM from ropes so it hangs vertically with the transducer pointing up.   
3. Select the VR3 ID number from the list of receivers at the bottom of the software window.  If the correct 

receiver number is not in the pull-down list, highlight an ID number in the box, enter the number on the 
computer keyboard, and press Enter. 

4. Click the “Connect” button in the bottom left corner of the software window.  The surface modem will 
then attempt to wake up the receiver, request its status and will numerically report the slant range, 
surface distance, and receiver’s tilt angle on the right side of the window.  These values will be 
periodically updated, at the rate selected for the Status Update Period (see section 3.2.3.4). 

5. Select the UWM Tilt Display command from either the speed buttons or from the Tools menu.  The 
software window will display the circular level display as shown here.   

6. Verify that the dot (shown here as magenta) is in the center of the circle or very 
close to it.  The center of the circle represents the vertical.  Movement of the dot 
indicates the receiver is now at an angle and gives the general direction in which 
the receiver has tipped.   

7. Deploy the VR3-UWM receiver (see the VR3-UWM Operating manual).    
8. Watch the location of the dot in of the receiver in the software as the receiver is 

lowered through the water to make sure it remains in the center of the circle.  If the 
dot has moved drastically, then reposition the receiver until it is in the center again.  
This is important for communication with the receiver. 

9. Place the receiver in its moored location so the dot is in the center of the circle.  If the angle is too great, 
then reposition the receiver so the angle decreases.  This is very important for modem communication.   

 
 



 

3.2.3.2 UWM Range Display  (VR3-UWM only) 
 
The UWM Range Display feature is used to locate a deployed VR3-UWM receiver, and help stay within 
communications range while performing VR3 operations.  When the feature is selected, the software 
window changes to show a target range circle on the left side of the window (see below).  The location of 
the VR3-UWM is in the center of the target circle and marked by the small cross-hair.   
 
The “Target Area”, which is blue in the picture below, represents the area in which the surface modem needs 
to be for communication with the VR3-UWM to be optimal (the colours are selected in Options - see section 
3.2.3.4).   

 
The surface distance of the surface modem from the receiver is represented by the 
ring in the same colour as that selected for “Current Location” in the Options 
window.  In the window below, this is the red ring.  The numeric version of this 
distance is shown in the “Surface Distance” box in the right side of the window.  
It’s also shown in the triangle to the top-left of the target range circle (see sketch to 
right).  For reliable communication with the bottom modem on the VR3-UWM, the 
“Current Location” circle must be inside the “Target Area” circle.   
 
Two “Current Location” rings of the same colour are displayed in the target circle 
when the surface distance changes rapidly between two consecutive measurements.  
The wider ring reflects the most recent range measurement and the narrow ring 
shows a previous measurement.  This is intended to help determine whether the 
boat is moving towards or away from the VR3-UWM.  
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The circle filled with the grid is the “Fringe Area” (the colour in the Options window and shown here is 
grey), and is a representation of the surface distance that matches the maximum range (350m) of the under 
water modem.  The “Fringe Area” will be close to 350 meters when the VR3-UWM is deployed in shallow 
water and much smaller when the receiver is deployed in deep water. 
 
A three dimensional representation of the finding process is shown in the picture below.  The colours in this 
picture match the colours in the software picture on the previous page. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
NOTE:  If UWM Range Display is selected when the receiver is connected through the service port, a large 
grey circle will appear instead of the target display announcing that the feature is only available with the 
modem.  Change the setting at the bottom of the window to “UWM”. 
 
The UWM Range Display feature is helpful to keep the surface modem as close as possible to the receiver 
while data is being uploaded (see section 3.2.2.1) from the VR3 to the computer.   
 
 
3.2.3.2.1 Find Deployed VR3-UWM 
 
To locate a deployed VR3-UWM, following the steps listed below. 
  
1. Move to the general area the VR3-UWM is known to be in.  This size of this general area depends on 

the acoustic conditions and the depth at which the receiver was deployed.  
2. Deploy the surface modem, if not already deployed. 
3. Select the UWM Range Display command from either the speed buttons or from the Tools menu.  The 

left side of the software window will change to a target range circle, as shown above. 
4. Select the VR3 ID number from the list of receivers.  If the correct receiver number is not in the pull-

down list, highlight an ID number in the box, enter the number on the computer keyboard, and press 
Enter. 

5. Click the “Connect” button in the bottom left corner of the software window.  The surface modem will 
then attempt to wake up the receiver, request its status and will numerically report the slant range, 
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surface distance, and receiver’s tilt angle on the right side of the window.  These values will be 
periodically updated, at the rate selected for the Status Update Period (see section 3.2.3.4). 

6. Move the boat until the “Surface Distance” decreases, making the “Current Location” ring shrink, and 
continue to move the boat until the ring is inside the “Target Area” circle.   

 
 
3.2.3.2.2 Negative Surface Range 
 
A negative surface range shown in the UWM Range display indicates that depth value for this receiver is 
greater than the current slant range.  This means that the depth value entered for this receiver is incorrect, or 
the ship is sinking.  Since it’s unlikely that the ship is sinking, the depth value needs to be changed.  This can 
be done in one of three ways: 
 
1. Manually enter a larger value in the “Depth” box at the bottom of the window. 
2. Right-click on the “Slant Range” value on the right side of the window (actually, anywhere in the box 

surrounding the value) and select “Set Depth to Current Range” from the list that appears (see picture 
below).  This will change the depth value to match the slant range. 

3. Right-click on the “Slant Range” value on the right side of the window (actually, anywhere in the box 
surrounding the value) and select “Enable Auto Depth Tracking” (see picture below).  This will 
automatically change the depth value to match the Slant Range value whenever it becomes less than the 
current setting.  This auto tracking is useful if you don’t know the depth at which your receiver was 
deployed.  As you move closer and closer to a position directly above the receiver, the depth will follow 
the slant range down to the minimum measurement.  Auto depth tracking is disabled by default and it 
will be disabled again after you disconnect from a receiver. 
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3.2.3.3 Tag Manager 
 
The Tag Manager window allows sensor tag information to be entered or edited and stored for data uploads.  
A group of sensor tags can be saved as a setup file and opened at a future time.  The Tag Manager window 
is explained in detail in section 3.3. 
 
 
3.2.3.4 Options… 
 
The options that can be set in the Options window, shown here, are the colours used with the UWM Range 
Display feature (see section 3.2.3.2) and times for the status update period.  The status update period is the 
length of time between status updates from the receiver.  There are two time settings, one for when the 
modem is idle (Idle) and the other for when the modem is uploading a log file (Upload).  These times can be 
changed at any time, even while the modem is busy.  The time settings have no effect when the receiver is 
connected through the service port. 
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3.2.4 Help menu 
 
The Help menu contains the sub-menus described below for your assistance. 
 
3.2.4.1 VR3HS Help 
 
The Content and Index command opens the Help Topics window to allow access to help information.  The 
Help Topics window contains the tabs Contents, Index, and Find which are explained below. 
 
 Contents 
 
To select a general topic for overall help, use the Contents feature.  Open a topic by double clicking on the 
book symbol next to the name, or on the name itself.  A list of sub-topics will appear to choose from. Double 
clicking on one of these sub-topics will open the help topics related to that general topic. 
 
 
 Index 
 
To select a specific topic, use the Index feature, which will display the complete list of topics in the help file.  
To select a topic, either move through the list (using the arrow keys or the scroll bar) until the desired topic 
is highlighted, or type the name in the box at the top of the window.  As the name is entered, the list will 
reflect the letter being entered.  For example, if the letter “t” is entered, the list will alter so the “t” section is 
shown.  Once the topic is highlighted, either select Display at the bottom of the window, or double click on 
the topic name. 
 
 Find 
 
To search for a specific word within a topic use the Find feature.  A word list must be created if Find has not 
been previously used.  Simply follow the on-screen instructions to setup Find.  If Find is not desired, select 
Cancel.  A list of topics containing the desired word is listed in the third box from the top.  Select a topic and 
click the Display button at the bottom of the window. 
 
 
3.2.4.2 About 
 
Information about the VR3HS software is shown in the About window.  This information includes software 
version number.   
 
A special sequence of keystrokes while the About window is open will put the software in Administrator 
mode.  The title bar at the top of the About window will indicate when Administrator mode is activated. 
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3.3 TAG MANAGER 
 
The Tag Manager window is the place to enter or edit sensor 
transmitter information.  Only tags with sensors need to be 
entered in this section.  Pingers (non sensor tags) do not need 
to be entered in the TAG MANAGER section. Tag Manager is 
opened in the Tools menu or by clicking the orange T speed 
button.  How to add or edit information is explained in section 
3.3.2.   
 
The left half of the Tag Manager window is called the PC Managed Setup and is used to enter and edit 
sensor tag information.  The information seen in the PC Managed Setup list is the tag setup contained in the 
PC software.  The right half of the window is called the Receiver Setup and is the actual tag setup used by 
the VR3 receiver.  When the Tag Manager window is opened, the software automatically requests the 
current setup being used with the receiver and displays it in the Receiver Setup half of the Tag Manager 
window.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The setup for tags can be passed between the two halves of the Tag Manager window by using the arrow 
buttons in the middle of the window.  To copy a sensor transmitter from the PC Managed Setup list (on the 
left) to the Receiver Setup (on the right), select the desired tag by clicking it once with the mouse and then 
click the right pointing arrow in the middle of the window.  The tag now also appears on the right half of the 
window and will be used to decode the sensor data when the logs are retrieved from a VR3 receiver.   
 

Do not enter slope and intercept 
information if data will be imported into 
VUE software.  For the VUE software to 
properly post-process data, slope and 

intercept information must be entered into 
VUE and not in VR3HS software. 



 

TIP: To select more than one tag at once, select the first tag then hold the Control key on the computer’s 
keyboard while you select the other tags with the mouse arrow.  Press the Shift key instead to select 
blocks of tags. 

 
3.3.1 File 
 
The File menu in the Tag Manager window is separate from the File menu in the main software window 
(see section 3.2) and contains the sub-menus described below. 
 
 
3.3.1.1 New 
 
The New command clears the PC Managed Setup (left half of window) to allow a new setup to be entered.  
If changes had been made and not saved when the New command is given, a prompt appears asking if the 
changes are to be saved before the information is cleared. 
 
3.3.1.2 Open 
 
The Open command in the Tag Manager window allows a previously saved resource file to be opened (see 
section 3.4.3 for more information on resource files).  Only the resource files located in the directory are 
displayed in the Open window to make file identification simpler.   
 
3.3.1.3 Save 
 
The Save command allows changes made to a resource file to be saved.  What a resource file is named is 
determined by the user, but the extension must remain .xres or the file can’t be read by the software. 
 
3.3.1.4 Save As… 
 
The Save As… command allows the resource file name or location to be changed.   
 
3.3.1.5 Exit 
 
This Exit command closes the Tag Manager window but won’t close the software.  This is the same as 
clicking the X in the top right corner of the window. 
 
 
3.3.2 PC Setup 
 
The PC Setup menu allows sensor transmitter information to be setup.  It’s also used to combine separate 
resource files. 
 
3.3.2.1 Add 
 
The Add sub-menu contains two options, one to add a sensor tag and the other to add a map.  Adding a tag 
refers to entering a sensor transmitter’s information so the received data can be displayed in the correct 
units, which must be done for each sensor transmitter being used with the VR3 receiver.  The ability to add a 
map is not applicable to the VR3 receiver but is listed for future compatibility with the VR100 receiver. 
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3.3.2.1.1 Add Tag 

 
A sensor transmitter’s information must be entered in the VR3HS software for the data to be displayed in the 
VR3-UWM data file correctly.  NOTE:  If the VR3-UWM data will be imported into VUE software, then do 
not enter the sensor transmitter’s slope and intercept information.  This is important for maintaining the 
necessary file formatting for the VUE database.   
 
A new sensor transmitter can be added by following the steps listed below. 
 
1. Select “Coded256Sensor” by either using the PC Setup menu or by clicking the sensor type in the PC 

Managed Setup on the left half of the screen.  In either case, the bottom left corner of the Tag Manager 
window will display data entry boxes similar to the two samples shown below.  Initially the boxes are 
empty, as seen in the Tag Manager window in section 3.3.   

 
2. Enter the information as identified in the window.  The information needed is listed below.  The 

information is found in the Transmitter Specification manual shipped with the sensor transmitters. 
a. Serial number 
b. Frequency in kilohertz (kHz) 
c. Coded map – select from the default maps in the pull-down list 
d. ID number 
e. Submap – either A, B, C, or D 
f. Sensor type – temperature or depth 
g. Slope 
h. Intercept 

 
3. Click the “Update” button.  The tag is now added to the list shown in the PC Managed Setup half of the 

window (on left). 
 
 
NOTE:  The tag information must be transferred to the Receiver Setup list (see section 2.2.10) for use with 
the VR3 receiver. 
 
Sensor transmitters that have already been entered can be edited.  Follow the steps below to edit an existing 
sensor transmitter. 
 
1. Highlight the desired tag in the PC Managed Setup list (left side of Tag Manager window).  The 

information already entered is displayed in the bottom left corner of the window but is not accessible for 
editing. 

2. Click the “Edit” box in the bottom left corner of the window to allow access to the information. 
3. Edit the tag information as needed and click the Update button. 
 
 
 
 
3.3.2.2 Import 
 
The Import feature in the Tag Manager window allows multiple resource files to be combined into one file.  
Follow the steps listed below to merge resource files. 

Do not enter slope and intercept information if data will be imported into VUE software. 

NOTE: 
Only tags with sensors 
need to be entered in 
the software.  Pingers 
don’t need to be 
entered. 



 

 
1. Open one of the files to be merged (see 3.3.1.2). 
2. Select Import from the PC Setup menu in the Tag Manager window.  The Import window will open. 
3. Select the second resource file to be merged and click the “Open” button. 
4. Repeat steps 2 and 3 until all the desired resource files are merged. 
5. If desired, save the merged file using the Save As… feature (see section 3.3.1.4) 
 
The merged file will not contain any duplication of information.  For example, if the sensor transmitter with 
the serial number 6739 is setup in two different resource files, it will only appear in the merged file once. 
 
3.3.2.3 Show All Items 
 
The Show All Items menu selection will show all the VEMCO tag types, including those that are not 
compatible with the VR3 receiver.  The non-compatible tag types will be hidden when the Show VR3 Items 
menu option is selected (it was the Show All Items option). 
 
 
3.3.3 Receiver Setup 
 
3.3.3.1 Refresh 
 
The Refresh command retrieves the current sensor tag setups relate to the receiver and displays those setups 
in the right side of the Tag Manager window (called Receiver Setup).  The Refresh command is 
automatically executed each time the Tag Manager window is opened. 
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3.4 FILE TYPES 
 
3.4.1 Data File 
 
Data files are automatically created from the VR3 log file (see section 3.4.2) when the Upload Logs 
command is used (see section 3.2.2.1).  These data files are automatically saved in the directory selected 
using Choose Directory (see section 3.2.1.1) using the naming convention shown below.  A data file is 
stored in ASCII text format with a comma as a delimiter, very similar to VR2 data files. The data file can be 
viewed either within the VR3HS software (see section 3.2.1.2), or with a text editor, or be imported into a 
spreadsheet program.  Recent versions of the VR2 PC software are also capable of displaying these files. 
 
The data files are saved using a standard file naming system.  A sample file name is shown below.  The ID 
number in the file name is the ID number of the receiver the data was loaded from, and the date and time are 
when the data file was created on your computer. 
 
 
 
 
 
 
 
A line in the data file beginning with an asterisk (*) is a text header line and is usually used to identify the 
information contained in the next line.  Text header lines contain information such as: 
 

• data format (firmware version number) 
• file name 
• receiver serial number 
• model information 
• blanking interval 
• percentage of memory used 
• total number of sync pulses 
• number of pulses received 
• number of total detections 
• computer time at download 
• the sub-map name (A, B, C, or D), sync, bin, and transmitter type 

assigned to each of the four receiver channels 
 
The end of the text header section of the data file is marked with the line "*100,EOH" which stands for "End 
Of Header".  The last four header lines identify the contents of the data lines that follow the EOH line.  Data 
lines begin with the "greater than" symbol (>).   
 
 
 
 

VR3-UWM_00003_D2005.04.20T14.09.42_69kHz.vr2 
                             ↑     14243   123 
                              ID           Date            Time 
                Number 



 

3.4.2 Log files 
 
The log file, which has the extension .zlog, is a compressed binary file containing logs uploaded by the 
Upload Logs (see section 3.2.2.1) command.  It contains the same information as data files, written in an 
alternative format that has been specifically designed so it can only be opened by VEMCO data analysis 
applications.  The log file is automatically saved in the directory selected with the Choose Directory 
command (see section 3.2.1.1).  NOTE: Although these files cannot easily be edited, they are not encrypted 
and should not be considered secure. 
 
 
3.4.3 Resource files 
 
A resource file, which has the extension .xres, contains the setup information for sensor transmitters that 
have been entered in the software.  These files must be manually saved (see section 3.3.1.3) as they aren’t 
automatically created by the software.  Resource files are beneficial because they eliminate the need to 
manually re-enter the sensor transmitter information.  They can also be merged together using the Import 
function (see section 3.3.2.2). 
 
 
3.4.4 Setup files 
 
The VR3HS software automatically stores all it's settings in a file called VR3HSSetup.xml that is located in 
the same directory that the software is installed in.  This file stores all the software settings (e.g. colour), all 
the global receiver settings (e.g. sensor transmitter information) and all the receiver-specific settings (e.g. 
depth, user comment, etc).  The file is updated each time the software program is closed.  The setup file is 
used with the Add/Remove Receivers function (see section 3.2.1.3) to import receiver configurations.  It can 
also be copied to another computer.  
 
NOTE:  If a VR3HSSetup.xml file is replaced with a VR3HSSetup.xml from another computer, the 
configurations in the old VR3HSSetup.xml file have been overwritten by the configurations in the new 
VR3HSSetup.xml file.   
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4 APPENDICES 
 
 
4.1 SOFTWARE REQUIREMENTS AND INSTALLATION 
 
4.1.1 System Requirements 
 
The VR3HS software is a Windows©2000/XP based software application that can be executed on any IBM 
compatible personal or mobile computer with the following configuration: 
 
Minimum Pentium II Processor, 366MHz  
Minimum 4 MB Video RAM 
128 MB RAM 
Minimum SVGA Monitor 256 Colour 
CD drive for program installation 
One 9-pin RS-232 serial port (Note: USB serial adapters are not recommended for use with the VR3 because 
of the inconsistent quality of these devices) 
 
 
4.1.2 Software Installation 
 
The VR3HS software is a Windows© application.  VEMCO assumes customer familiarity with Windows 
terminology.  
 
To install the VR3HS software, follow the steps listed below. 
 
1. Insert the Install compact disk (CD) into the CD drive. 
2. From the Start menu in Windows, select Run. 
3. Type “X:\VR3HS Setup.exe” where the “X” represents the letter associated with your CD drive.  
4. Follow the on-screen instructions. 
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4.2 TROUBLE-SHOOTING 
 
The following tips may help if problems are encountered.  If the problem you’re experiencing isn’t included 
in this section, please contact VEMCO. 
 
4.2.1 Communication Problems 
 

Problem Possible Solution 

Can’t communicate with a 
deployed VR3-UWM 
receiver. 

1. Check that the correct receiver address is being used.  Use the New 
button in the Configuration tab to check which receivers are within 
communication range of the surface modem. 

2. Make sure the surface modem is within communication range of 
the bottom modem. 

3. Check the serial port number in the software is correct (see section 
3.1.1). 

Can’t communicate with a 
VR3-UWM receiver during 
in-air test. 

1. Check that the correct receiver address is being used.  Use the 
New button in the Configuration tab to check which receivers are 
within communication range of the surface modem. 

2. Connect directly to the service port (see section 3.1.2). 
3. Check the serial port number in the software is correct (see section 

3.1.1). 
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4.3 GLOSSARY 
 
Blanking Interval:  The Blanking Interval is the length of time (in milliseconds) after an acoustic signal has 

been received in which the VR3 will ignore any subsequent signals.  This is to eliminate the 
reception of echoes by the receiver.   

 
Channel:  A channel in the VR3 is a group of configuration settings used to listen to VEMCO tags.   
 
Coded Map:  A coded map is a collection of code space labels (for example A69-1105, A69-1303) 

operating on the same frequency.  There are standard maps for use with VEMCO’s coded tags.   
 
The receiver must be set to the same coded map as the tags for the tags to be detected and identified 
correctly. The coded map for tags is set at the time a tag is ordered and can not be changed after the 
tag is built. 

 
Coded tags:  Coded tags transmit a series of acoustic pings to form an ID (identity) number recognized by 

the receiver.  The pings form a “ping train” that is usually followed by either a fix or random delay.  
The type and length of the delay is set at the time the tag is ordered and can’t be changed once the 
tag is built.   

 
Continuous tags:  Continuous tags transmit the acoustic pings continuously, without long delays between 

transmissions.  Continuous tags are available with or without sensors. 
 
Coordinated Universal Time (UTC):  UTC is the international time standard. It is the current term for 

what was commonly referred to as Greenwich Mean Time (GMT).  Zero (0) hours UTC is midnight 
in Greenwich, England, which lies on the zero longitudinal meridian.   

 
Pinger:  A VEMCO tag that contains no sensors.  It can have either a coded or continuous transmission 

schedule. 
 
Tag:  A VEMCO tag is an acoustic transmitter that is attached to a marine creature and transmits an acoustic 

signal.  The acoustic signal is received by a VEMCO receiver.  VEMCO tags can transmit either a 
coded or continuous signal, with or without sensor data.  After a tag is powered, it will continue to 
broadcast according to factory setup until powered down.   

 
Sensor transmitter:  A VEMCO tag that has at least one sensor.  The type of sensor is usually included in 

the transmitter’s name.  For example, a V16P has a pressure (depth) sensor and the V16T has a 
temperature sensor.  A sensor transmitter can also have either a coded or continuous transmission 
schedule.  
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open a resource file, 9 
serach for a deployed VR3-UWM, 9 
transfer PC Setup list to Receiver Setup, 10 
update coded map, 12 
use multiple computers and receivers, 10 
view a data file, 11 

Import a resource file, 32 
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Slant Range, 27 
Software 

Installation, 36 
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Exit, 31 
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